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Introduction
Forman Interactive's Internet Creator is the fastest and easiest way to create and manage your 
organization's web site.
Internet Creator allows you to create full-featured, multi-media enhanced, commerce-enabled web sites 
without knowing anything about HTML (the programming language of the web).    All you need to do is 
enter text, choose graphics and sounds, and lay out your site's pages - Internet Creator does the rest!
Internet Creator also provides support for advanced features like forms, frames, background images, 
Java applets, tables, lists and more!



Features
Power and Flexibility
· Internet Creator creates fully customizable Web pages that can include links, graphics, sounds, 

movies, lists, frames and tables.
· You can add an unlimited number of pages to your site.
· You can import and attach existing HTML documents.
· Site management and page creation in one package.

Internet Commerce
· Internet Creator's transactional items provide an easy and secure way to sell your products on the 

Internet.
· Allow volume discount for your products.
· Advanced shipping options - you can use a variety of carriers and shipping cost calculation schemes.
· Built-in support for sophisticated searches based on your products.
· Support for an interactive shopping basket.

Page Design Features
· Automatic navigation buttons and links on every page.
· "Last modified" date stamp on every page.
· Advanced font options including TrueType font selection, font size, font color, bold, underline and 

italic.
· Choose from a variety of themes to give your site a consistent professional appearance.
· Tables allow you to position text and graphics precisely.

Wizard-Based Site Creation
· Site Setup Wizard allows you to create a "skeleton" web site which you can easily expand.
· Server Options Wizard walks you through the steps required to set up your site with any hosting 

service.
· FTP Wizard allows you to easily upload your site to any hosting service.
· Form Wizard makes it easy to create complex fill-in forms.
· Commerce Wizard sets up all of the features necessary    to maintain an online catalog or store.

Built-in forms
· Structured E-mail form allows users to easily send information to you.
· Search form allows users to search your site.
· Order form with Netscape secure posting allows users to order your products.

Technical Features
· Local processing - all HTML generation is done on your computer, not on your web server.
· Full multi-media implementation - pages can include images, audio files, video files or any type of 

binary file.
· Microsoft Access database structure. (Microsoft Access is not required to run Internet Creator)



Using Internet Creator to Create a Web Site
Step 1: Plan your web site
It is important to decide on a layout for your site before you start entering the data. Good planning is 
essential in order to create a well organized site that allows easy access to all of your information. Think 
about how the information you want to include in your web site fits into this structure.

Step 2: Create and setup a new site
Once you have planned your web site, you need to create the site file and setup the sites basic options 
(your E-mail address, your sites color scheme, etc.). Internet Creator uses several wizards to automate 
these tasks. 

Step 3: Edit your site
Now comes the fun part - creating the pages and paragraphs that make up your site. You can add text, 
images, forms, transactional items, background images, Java applets, tables, lists and more. 

Step 4: Publish your site
When you have finished creating your site, you need to get the web site files to your hosting service. 
Internet Creator provides a number of tools to make this easy - including automatic FTP upload and the 
Server Options Wizard.



New Features
New views
Internet Creator's Main screen has been greatly improved - you can now view your site in the standard 
"tree" format and in a browser-style preview.
Internet Creator now has the ability to launch your web site in a local browser. This allows you to see what
your site will look like in Netscape Navigator, Microsoft Internet Explorer or any browser you choose.
Internet Creator can also launch a source code viewer to let you see the HTML code behind any of your 
site's pages.

Improved text editing
All of Internet Creator's paragraph dialog boxes have been redesigned to allow real "WYSIWYG" text 
editing. 

Improved table paragraphs
Internet Creator's new table paragraph gives you ability to precisely position text, images and links on 
your pages. 

Templates
You can now save single pages or paragraphs as "templates". These templates can then be inserted 
anywhere in any Internet Creator project. Internet Creator also comes with a variety of pre-created 
templates such as "About our company", "personnel roster" and "customer testimonial". 

Support for custom forms
Forms are one of the most powerful and popular features of the World Wide Web. They allow visitors to 
your site to enter information in a variety of formats. Forms can be as simple as a single "Yes or No" 
question, or as complicated as a detailed order form.
Internet Creator now allows you to create your own custom forms - choose from a variety of input field 
types - lists, check boxes, text fields and more! 

Improved Commerce features
Internet Creator's Transactional items provide a structured format for offering products, prices and 
services. Our Transactional items, already the most sophisticated available in any Web creation software, 
have been made even more flexible and powerful.
Internet Creator now allows to create custom attributes for your transactional items. For example, you can
offer your products in a variety of sizes and colors, without creating separate Transactional items. You can
even add price adjustments based on these attributes - for example, you can offer plain Tshirts for $6.00, 
and T-shirts with a logo for $0.50 extra.
You can now calculate shipping charges based on total order weight, total order value, number of items 
ordered or on a per item basis. You can also offer volume discounts for shipping. 
Internet Creator lets you import Transactional items from a variety of databases. This allows you to create
a web site based on your existing inventory database. A variety of database formats are supported 
(including Access, Paradox, FoxPro, Btrieve, DBase, Peachtree and Quickbooks).

Integrated FTP uploads
Internet Creator's automatic FTP upload feature has been redesigned to allow "incremental" uploads of 
your web site. This means that if you change just a few pages on your site, you don't need to resend 
every single file - just the ones that have changed.

Support for Java applets
You can now easily include Java applets in your site. Please note: this feature is only available when 



using Internet Creator with Windows 95 or Windows NT.



How to Contact Technical Support
You can contact technical support on the World Wide Web, by email or by telephone.

On the World Wide Web:
We maintain an Internet Website at http://support.forman.com.    It contains the answers to the most 
commonly asked questions, and is the best source for software updates and patch files.

By Email:
The following email addresses are a great source for assistance.
General Information To receive general information about our products, and services, address 

your e-mail to info@forman.com. This address is monitored by an Auto-
Responder and will immediately send you information 24 hours a day.

Technical Support For technical questions regarding Internet Creator and Hosting Services, 
address your e-mail to support@forman.com

Domain Name
Registration

For inquires about or status of domain name registrations, address your 
email to internic@forman.com.

Internet Creator
Software

For information about or questions regarding Internet Creator, address your 
email to sales@forman.com.

Web Site Uploading To inquire about uploading your Web Site or using e-mail to send your site for 
upload to our servers, address your e-mail to upload@forman.com. Be sure 
to include your Forman Interactive Account Name and FTP Password.

Comments about
Our Web Sites

To report problems or submit suggestions regarding the register.com mall or 
formaninteractive.com, address your e-mail to webmaster@forman.com.

Hosting on Our
Servers

For inquires about our hosting services, server/telecommunication 
specifications and pricing, address your e-mail to hosting@forman.com.

Marketing Your Web
Site

For inquiries about our Directory Listing Service or other Web site marketing 
programs, address your e-mail to sitemarketing@forman.com.

By Telephone
If your circumstances require technical help from a Forman Interactive support representative, here's how
to get prepared before you call:
· Have your product Registration number ready. This number can be found in the Help | About menu. 
· Be at the computer that is experiencing technical difficulty. 
· Be prepared to describe the problem thoroughly or re-create it. 
· Note the exact wording of any error messages. 
· Know the version number of your product you are using.

Technical Support (503) 624-1420
Support Hours are Monday - Friday 6:00 a.m. to 6:00 p.m. PST

Sales Only (800) 2-WWW-NET (800) 299-9638
Business Hours are Monday - Friday 9:00 a.m. to 7:00 p.m. EST

Corporate Offices (718) 522-2260 Fax (718) 522-0267
Business Hours are Monday - Friday 9:00 a.m. to 5:00 p.m. EST



The Tree View
You can picture your web site as a book, with pages and paragraphs. The Tree view shows all of the 
pages and paragraphs of your web site in a hierarchical format.

Each of the pages in your web site is represented by an icon that is open or closed - when the icon is 
open, all sub-items are displayed; when the icon is closed, they are hidden. You switch between open and
closed by clicking on the icon.

Home page - paragraphs hidden Home page - paragraphs shown
Web page - paragraphs hidden Web page - paragraphs shown

The paragraphs on a page are represented by icons as well:
Link to an imported web page Internal link
Remote Internet link Text paragraph
List paragraph Table
Transactional item Form
Image file Audio file
Video file Binary file
Horizontal rule Java applet

Each page also has a Page Style Options icon, which represents the options available for each page.
Page Style options



The Browser View
The Browser view shows the pages of your site as they will appear in a real web browser.



Switching Views
Internet Creator allows you to view your site in two ways "Page Preview" or "Page / Paragraph View". You
switch between the views by clicking the view buttons on the Editing Toolbar:

Page Preview Page / Paragraph view

Page Preview: Shows the Tree view on left and the Browser preview on the right
Page / Paragraph view: Show the Tree view on the left and a paragraph summary on the right.



The Editing Toolbar
Create a new web 
site.

Open an existing 
site.

Saves all changes 
you have made to the
current project.

Cuts the selected 
paragraph to the 
clipboard.

Copies the selected 
paragraph to the 
clipboard.

Pastes a paragraph 
at the selected 
location.

Pastes a "virtual" 
paragraph at the 
selected location.

Generates the HTML
files for your site.

Uploads your site to 
your web host.

Closes all the pages 
on the tree.

Opens all the pages 
on the tree.

Displays the HTML 
code of the current 
page in your default 
source code viewer.

     
Displays your site in a web browser. You can use Netscape Navigator, 
Microsoft Internet Explorer, or any other web browser you choose.



The Paragraph Toolbar
The 15 controls on the Paragraph toolbar represent the types of available paragraphs:

New Page Internal link Text

List Table Transactional Item

Remote Internet Link Form Image file

Audio file Video file Miscellaneous file

External HTML file Horizontal rule Java applet



Creating a New Web Site
To create a new site:
1. Select "New Web Site" from the File menu, or click on the New Web Site button.
2. Choose a location (a drive and directory) for your new site.
3. Each new web site needs its own directory. Enter a directory name of up to 8 characters.
4. Enter a name to name to identify your web site. Your company's full name is a good choice. (This 

name can be more than 8 characters.)
5. Click on the OK button. Internet Creator will ask if you want to use the Site Setup Wizard.



Using the Site Setup Wizard
 The Site Setup Wizard allows you to easily set up most of the basic features and options for your new 
web site. Whenever you create a new site, Internet Creator will ask if you want to run the Site Setup 
Wizard - you can also run the wizard at any time by selecting Site Setup Wizard from the Setup menu. 
The wizard helps you do the following: 
· Enter your organization name. This will be used as the name of your web site.
· Select a theme for your sites pages. A theme consists of a background image, navigation buttons, 

link icons and a text color scheme.
· Add a This page last modified stamp to the bottom of every page.
· Add a Table of Contents page to your site and a Contents button to every page.
· Enter your E-Mail address. 
· Enter a header and footer text to be used on each page of your site.
· Create a Javascript banner that appears in the status bar of any web browser viewing your pages. 

Home Page Wizard
The first time you run the Site Setup Wizard, Internet Creator will ask if you want to run the Home Page 
Wizard. The Home Page Wizard helps you do the following:
· Add some text to your home page that describes your site or organization.
· Create a logo for you home page.
· Create a Company History page for your site.
· Create a How to contact us page for your site.
· Adds an additional free-form page to your site.



About Your New Site
Internet Creator creates an html directory to hold the files that make up your web site. This directory 
contains .htm files, image files (usually in .gif and .jpg format), and any other files you have included in 
your site. 



Opening an Existing Web Site
To open a web site, select open Web Site from the File menu, select a site from the list, then click the 
Open button.
If you have moved a site, or are trying to open an Internet Creator 3.0 project, it may not appear in the list.
If this happens, click on the Browse button to locate the site.

Recently accessed files
Internet Creator keeps track of the last 4 sites you have accessed, and lists them at the bottom of the File 
menu:

To open one of these sites, select its entry on the menu.



Converting Internet Creator 3.0 projects
Projects you have created using Internet Creator version 3.0 need to be converted to Internet Creator 4.0 
format before you can edit them. To convert and open a project:
1. Select Open Project from the File menu.
2. Click on the Browse button.
3. Locate project (project files are always named db1.mdb)
4. Click the OK button. Internet Creator will ask if you would like to upgrade your project database.
5. Click the Yes button. Internet Creator will convert the site to the new format. On large sites, this may 

take several minutes.



Saving a Copy of a Site
To save a copy of your site (to make a backup, for example):
1. Select Save Site As… from the File menu
2. Choose a location (a drive and directory) for the site.
3. Enter a directory name of up to 8 characters.
4. Enter a name to name to identify the copy of your web site. (A name like Planet Books - Backup is a 

good choice.)
5. Click on the OK button.



Deleting a Web Site
To delete a site, select Delete Web Site from the File menu, select the site you want to delete, then click 
the Delete button. (Please note, you cant delete a site while it is open.)
Deleting a site in Internet Creator deletes all of the associated files (including any images and other files 
you may have added). Be very sure that you mean to delete a site before you do it!



Viewing your Site in a Browser
Although Internet Creators Browser view gives a good idea what your web pages look like, we still 
recommend that you view your site using a standard Web browser. Internet Creator allows you to 
automatically view your site in Netscape Navigator, Microsoft Internet Explorer or in any other browser 
you choose. To view your site click on one of the three browser buttons on the toolbar:

Netscape Navigator Microsoft Internet 
Explorer

Other browser

The first time you click on any of the browser buttons, Internet Creator will display the Setup Browser 
dialog box.
1. Select a browser to set up. You can select Netscape Navigator, Microsoft Internet Explorer or Other.
2. Find the browser on your hard drive.

a) If you selected Netscape Navigator or Microsoft Internet Explorer, you can click on the Auto Find 
button to locate the browser. Internet Creator will search your hard drive for netscape.exe or 
iexplore.exe. 

b) If you have a different browser, click on the Browse button to locate the browser yourself.
3. Click OK. 
Many of Internet Creators dialog boxes contain a Quick View button next to the Help button:

Click on the button to save any changes, generate new HTML code for the current page and then launch 
your default browser with the current page displayed. 



Viewing your Web Site's Source Files
Although you dont need to worry about HTML code when using Internet Creator, it can be useful to take a
look at the code behind your web pages.

Selecting a source viewer
When you first install Internet Creator, the Windows Notepad program is your default source code viewer. 
If you would like to select a different program to view source code with, select Set Source Viewer from the
Setup menu.
Click on the … button to browse your hard drive for the viewer.

Viewing the source code
To view the source code of a page, select the page (in the Tree view), then click on the 
View Source button. (You can also select View Source from the View menu.)



Adding Paragraphs
To add a paragraph to a page:
1. In the tree view, select (click on) the item just below where you would like to add the new paragraph:
2. Click on the toolbar button that represents the type of paragraph you want to add. (You may also 

select the paragraph type from the Insert Paragraph menu.)
3. Internet Creator will display a dialog box that allows you to set content and style options for the new 

paragraph. All of the paragraph types and their associated dialog boxes are discussed over the next 
few screens.



Adding a New Page to Your Site
You add a page to your site by creating a new page link on an existing page. Select a location for the link,
then click on the New Page Link button. (Remember, new items are added above the current selection.) 
The new page link consists of an icon, the link text and a description of the new page.

Link text This is the text that the user clicks on to activate the link.
Link icon Click on the Select Icon button to choose an icon to represent 

the link. You can position the icon to the left or right of the link 
text. (For help selecting images, click here.)

Descriptive text You can enter a description of the link. This text will not be 
"clickable".



Entering and Formatting Text
Most of the paragraph dialog boxes contain text entry fields. You can type and edit the text just like you 
would in a word processor.
To allow you to easily apply standard formatting effects to the text, Internet Creator displays the Format 
Strip:

This list contains the names of all of the TrueType fonts on your system. 
You should use relatively common fonts, like "Times New Roman" or 
"Arial". (You may choose any font name you want, but unless people 
visiting your site have the same font installed on their system, they won't 
see it.)
The font sizes in HTML text are not measured in points, as they are in 
most word processors. They are measured on a scale of 1 to 7, where 1 
is the smallest and 7 is the largest.
3 is a good size for 'regular' text.
Click this button to change the color of text. (This setting applies to all 
text in the text box, not just the selection.)

You can set text to bold, italic, strikethrough or underlined. Just select 
the text, then click on the appropriate button. (Some browsers may not 
support the strikethrough and underline styles.)
You can format text as left justified, right justified or centered.

Click on the image button to include an image in a text paragraph. For 
help selecting images, click here.
Click here to make the selected text a link to an URL. 

Click here to make the selected text a link to another paragraph in your 
site. Choose a paragraph from the list, then click OK.
To make the process of inserting special characters a little easier, 
Internet Creator includes a built-in Special Characters Keyboard.
Click on the buttons representing the characters you wish to use - their 
HTML codes will appear in the text box at the top of the window. When 
you are done selecting characters, click the OK button and Internet 
Creator will insert the special text into your paragraph.
Normally, web browsers reformat the text in a paragraph to exactly fit in 
the browser window. If you would like the text to appear exactly as you 
enter it, click on the Pre button. (This setting applies to all text in the text 
box, not just the selection.) 

Using Images and Icons
Adding an image to a paragraph
Most of Internet Creator's paragraph types have the option to include an icon or an image in the 
paragraph. To include an image (or to set image options):
1. Click on the dialog box's Select Icon button or Select Image button. You can also click on the Format 

Strip's Image button. Internet Creator will display the Image Viewing and Scaling dialog box.
2. Click on the Select Image button. Internet Creator will display the Select a Picture dialog box.
3. Locate and select the image.
4. Click the OK button. If the image you selected is not in .GIF or .JPG format (the standard image 

formats of the web), Internet Creator will ask if you would like to convert the image.

You may choose .GIF, .JPG or no conversion. Internet Creator will then redisplay the Image Viewing 



and Sizing dialog box.
5. Resize the image (optional). You can change the height and width by entering new values - click on 

the Apply button to make the changes. Click on the Standard Icon Size button to resize the image to a
good size for icons and thumbnails.

6. Click the OK button.

Removing an image from a paragraph
1. Click on the Select Image or Select Icon button in the paragraph's dialog box.
2. Click on the Remove Image button.

Resizing an image
To resize an image, click on the Select Image or Select Icon button in the paragraph's dialog box, then 
follow the directions for adding an image starting at Step 5.



The URL Builder
Several of the paragraph types create links to external (not part of your Internet Creator project) pages or 
resources. The dialog boxes for these paragraphs require you to enter an URL (Uniform Resource 
Locator) for the resource you wish to link to. You can type the URL directly, or you can use the URL 
Builder to make sure that the URL is correctly formatted. Just click on the URL Builder button:

To use the URL Builder, select the resource type you want to reference. The URL Builder will change the 
rest of the fields to reflect the addressing format of the type you selected.



Text Paragraph

Use a text paragraph to add text to your web site. You can type text into the text box provided, or you can 
import an existing text file.

Importing text Click on the "Import text" button to select a text file to import 
into the text box. You can then edit the text as required.

Suppress character
formatting

Fill this checkbox if you are entering any HTML tags in the 
text. This prevents Internet Creator from reformatting the text 
and possibly interfering with the behavior of the tags you 
enter.



List Paragraph

A list paragraph consists of a list heading and a series of listed items. The items in the list may be 
numbered or marked by bullets or icons.

List caption This is descriptive text for the list. Click on the Select Icon 
button to choose an icon to represent the list. You can position 
the icon to the left or right of the descriptive text. (For help 
selecting images, click here.)

List items Enter the list items (each line becomes a separate list item.)
List options You can create a list with bulleted items, numbered items or 

the items may be set off using an item icon.
Item icon If you select "Iconized List", click the Select Item Icon button to

select an icon for the items.



Table Paragraph

A table paragraph is a series of cells grouped into columns and rows. Internet Creator makes it easy to 
create complex tables for your web site. There are two tabs on the Table Paragraph dialog box: Data and 
Appearance.

Table Data
Caption Descriptive text for the table. The caption can appear above or 

below the table.
Cells To enter information into a cell, click on the cell you want, then 

enter text into the text area below the grid.
Zoom This changes the sizes of the cells as they appear in the 

dialog box. This can make it easier to see the text, it does not 
affect the appearance of the table in a browser.

Append Col Adds a new column to the right of the current selection.
Insert Col Adds a new column to the left of the current selection.

Delete Col Deletes the current column.
Append Row Adds a new row below the current selection.

Insert Row Adds a new row above the current selection.
Delete Row Deletes the current row.
Swap Cells Exchanges the current cell with an adjacent cell

Table Appearance
Center table Centers the table on the web page.

Table width and height You can set the height and width of the table as a percentage 
of the visible area of the browser window, or in pixels. For 
example, if you set the Table Width field to 50, and select the 
"% of page" option, the table will always cover half of the 
browser window, even if the user resizes the window. If you 
set height or width to 0, the browser will automatically format 
the table.    

Cell padding The space, in pixels, between the text in a cell and the cell 
border.

Cell spacing The space, in pixels, between each cell.
Border size The size of the table's border, in pixels.



Horizontal Rule

The horizontal rule is a stylistic element that visually separates sections of a web page. A rule can be 
either a line or an image file.

Rule type This may be "Use line" or "Use image." For line, you may add 
a 3-d shadow. For images, click "Select image" to choose an 
image to use as a rule.

Size If you leave "Set width and height" unchecked, the web 
browser will size the rule automatically. If you check this option,
you can set the size yourself.

Alignment The horizontal alignment of the rule.



Image Paragraph

Internet Creator's Image paragraph lets you images and links to images on your pages. There are five 
basic image paragraph types:

Text link to image Creates "clickable" text that displays the image.
Thumbnail link to image A link to the image that is made up of a small "preview" of the 

image and some descriptive text
Iconic link to image A link to the image that is made up of an icon and some 

descriptive text.
Inline image The image is displayed in your web page, along with some 

descriptive text.
Image map Inserts an image map - an image with clickable hot spots. 

Creating the .MAP file requires the use of a separate utility, 
such as Boutell.Com's MapEdit

Image Paragraph Options
Selecting the image Click on the Select Image button. (For help selecting images, 

click here.)
Description/Link text If you select "Inline Image" or "Inline Image Map" this text will 

be used as a description for the image; otherwise, it will 
become a link to the image.

Append image size to
caption

Displays the image size next to the Description / Link text.

Text flows around image Allows text in the paragraphs that follow to wrap around the 
image. (Please note: this does work with centered images!)

Alignment For Iconic links and Thumbnail links, this is the position of the 
icon relative to the link text; otherwise, it is the position of the 
image on the page.

Picture frame size The thickness of the border around the image.
Select Icon

(Iconic link only)
Selects an icon for the link.

Thumbnail Size
(Thumbnail link only)

Resizes the image thumbnail.

Select Map
(Image Map only)

Selects the .MAP file.



Inserting an Audio File

Internet Creator allows you to use audio files in a variety of ways:
Link to audio file The user clicks on a link to launch a browser plug-in to hear 

the file.
Embed sound into page The browser's audio plug-in is embedded into the page. 

Typically there is a play button as part of the plug-in.
Background sound The sound plays continuously while the page is visible in the 

browser. (Choose your sound carefully - this can be very 
irritating!)

Audio Paragraph Options
File name To select a sound file, click on the Browse button.    

Audio link text This is the text that the user will click on to hear the sound. 
Click on the Select Icon button to choose an icon to represent 
the sound file. You can position the icon to the left or right of 
the link text. (For help selecting images, click 
here.)

Descriptive text Enter a brief description of the sound file. This text will appear 
below the link text.

Stamp file size It's nice for users to know how large a file is before they click 
on it. After you choose the audio file, you can click on the 
"Stamp File Size" button to include the file size into the link 
text or the descriptive text. 



Inserting a Video File

Internet Creator allows you to use several different types of video files in your web site. Supported 
formats are: AVI, VDO, VIV, MOV and MPG.

Video file To select a video file, click on the Browse button.
Embed in page When you choose the Embed option, the video clip will appear 

right on the web page. (This only works in browsers that 
support the embed option.) When the user double-clicks on 
the movie, it will start playing. If you don't choose the Embed 
option, the video clip will play in a separate window.

Link text This is the text that the user will click on to see the video. Click 
on the Select Icon button to choose an icon to represent the 
video file. You can position the icon to the left or right of the 
link text. (For help selecting images, click here.) This option is 
not available for embedded video files.

Descriptive text Enter a brief description of the video file. This text will appear 
below the link text

Stamp file size It's nice for users to know how large a file is before they click 
on it. After you choose the video file, you can click on the 
"Stamp File Size" button to include the file size into the link 
text or the descriptive text.



Inserting Other File Types

Internet Creator lets you place any kind of binary file on your web site. This allows you to include file types
that aren't covered by Internet Creator's existing Image, Audio and Video categories. For example, you 
can include Adobe Acrobat files, PostScript files and files that are supported by browser plug-ins.

File To select a file, click on the Browse button.    
Embed in page When you choose the Embed option, the file will appear right 

on the web page. (This only works in browsers that support 
the embed option, and have an appropriate plug-in for the type

of file you are embedding.) When the user double-clicks on the

file, the plug-in will be activated. If you don't choose the 
Embed option, the user will get a choice of downloading or 
viewing the file.

Link text This is the text that the user will click on to see the video. Click 
on the Select Icon button to choose an icon to represent the 
file. You can position the icon to the left or right of the link text. 
(For help selecting images, click here.) This option is not 
available for embedded files.

Descriptive text Enter a brief description of the file. This text will appear below 
the link text.

Stamp file size It's nice for users to know how large a file is before they click 
on it. After you choose the file, you can click on the "Stamp 
File Size" button to include the file size into the link text or the 
descriptive text. 



Internal Link

Internet Creator automatically creates general navigational links ("Home", "Next", "Up" etc.) on every 
page of your web site. You can also create additional links that lead to specific locations on your site. You 
can create links that lead to specific pages, or to any paragraph.

Link text This is the text that the user will click on to jump to the new 
location. Click on the Select Icon button to choose an icon to 
represent the link. You can position the icon to the left or right 
of the link text. (For help selecting images, click 
here.)

Descriptive text Enter a brief description of the link. This text will appear below 
the link text.

Link destination Scroll through this list to select the destination for the link.



Remote Internet Resource Link

Internet Creator allows you to insert links that lead to any location or file on the Internet. For example, you
can create links to other web sites or to specific FTP locations.

Link text This is the text that the user will click on to jump to the new 
location. Click on the Select Icon button to choose an icon to 
represent the link. You can position the icon to the left or right 
of the link text. (For help selecting images, click 
here.)

Descriptive text Enter a brief description of the link. This text will appear below 
the link text.

Destination URL Enter the URL (Uniform Resource Locator) for the destination. 
You can enter the URL by:
· typing the URL directly into the field.
· clicking on the down arrow next to the field. This allows you 

to choose from the list of URLs that you have already 
entered.

· clicking on the URL Builder button. The URL builder helps 
you build a properly formed URL. For help using the URL 
builder, click here.

Be very careful when entering this information, any spelling 
errors will render the link invalid.



External HTML File

If you have an existing web page that you dont want to re-create in Internet Creator, you can create a 
External HTML File link to that page. Internet Creator will then create a copy of the existing file in your 
projects HTML directory, and create a link to that page.

File name To select a file, click on the Browse button.    
Link text This is the text that the user will click on to access the page. 

Click on the Select Icon button to choose an icon to represent 
the file. You can position the icon to the left or right of the link 
text. (For help selecting images, click here.)

Descriptive text Enter a brief description of the file. This text will appear below 
the link text.



Inserting a Java Applet

Java Applets are a great way to make your page more interesting. Internet Creator comes with a variety 
of applets that are available as templates. (For more information on using templates, click here.) The Java
feature is only available if you are running Internet Creator under Windows 95 or Windows NT.
Files needed to run applet A Java applet always contains at least one .CLASS file. It may 

also contain .GIF files, .JPG files, etc. To select the files you 
need, click on the Add button. To remove a file, select it in the 
list, then click the Delete button.
You must also select a Main class from the drop-down list.

Alternate text If someone is viewing your site with a web browser that 
doesnt support Java, they will see this text instead.

Applet parameters The applet parameters, and the values for the parameters vary

from applet to applet. Enter the names for the parameters in 
the left column, and the values you would like to use in the 
right column.

Applet layout You can adjust the size and centering of the applet window.



Generating Your Site

To generate your entire site, click on the Generate button. Internet Creator will produce all of the HTML 
pages that make up your site.
If you would like Internet Creator to regenerate each page of your site as changes are made to it, set the 
"Auto-Generate pages" option, on the Tools menu. (This can slow things down considerably on a large 
site.)



Page Style Options
Page Style Options control the general appearance, the header, the footer and the frames for your pages.
You can set page style options for a single page, or you can set default page style options for your site.

Setting Page Style Options for a single page
There are a number of options that you can set for each web page. To set these options for a page, 
double-click on the page's Page Style Options icon:

Appearance options
Background image This image will be displayed behind all of the other text and 

graphics on your page. To change the image, or to remove it 
altogether, click on the Select Image button. (For help with 
selecting images, click here.)

Page colors To change one of these colors, select the radio button next to 
it, then select a new color from the color palette, or move the 
color sliders to change the proportions of red, green and blue 
in the color. To return all of the colors to their default values, 
click on the "Turn off custom color" button.
· The Background color is the color that is used to draw the portions of the background that are not 

covered by the background image. You should choose a color that is similar to the background 
image.

· The Normal text color is used for non-link text.
· The Link text color is used to indicate clickable text.
· The Followed Link color is used to indicate a link to a site that has already been visited.
· The Highlighted Link color is used to indicate that the user is clicking on the link.

Page Header options
Use Logo You may select a logo image that appears above the header 

text.
Header Text Text that appears at the top of the page

Use Link Caption as
Subheader

This is the text from the page link that leads to this page. Fill 
the checkbox to include the text.

Navigation Bar Turns the navigation bar on or off.
Navigation Bar Position You can put the navigation bar at the top of your page, or at 

the left side of your page.
Alignment For Navigation Bar Position Top, you can align the bar left, 

right or center.
For Navigation Bar Position Left, you can align the top, center 
or bottom.

Offset (Navigation Bar Position Top only)
The vertical position of the navigator bar. The position is 
relative to the other paragraphs on the page - if the position is 
0, the navigator bar appears at the top of the page; if the 
position is set to 2, the navigator bar appears just after the 
second element.

Rules For Navigation Bar Position Top, you can add a horizontal rule 
above and/or below the bar. (For help modifying the default 
rule style, click here.)
For Navigation Bar Position Left, you can add a horizontal rule 
above the bar.



Page Footer options
Navigation Links Creates navigation links at the bottom of the page

Rule Above Links Draws a horizontal rule above the links. (For help setting the 
default

Link Alignment May be horizontal or vertical.
Rule Above Footer Text Draws a rule above the footer text. (For help modifying the 

default rule style, click here.)
Footer Text This text appears at the bottom of the page.

Last Modified Date Stamp If this option is checked, Internet Creator will print the current 
date at the bottom of the page whenever the page is 
generated.

Frame options
Split with frames The current page will be created as the "source" side of a pair 

of framed pages. All link on the page will lead to the other 
frame. If you are using this option, it is best to turn off the 
navigation bar, navigation links and Java banners on the 
"child" pages.

Alignment You can put the source page at the top, left, right or bottom of 
the page.

Scrollbars If this is checked, the source frame will have scrollbars
Resizable If this is checked, the frame border will be resizable.

Frame Size You can set the source frame size in pixels or as a percentage 
of the window size.

Border Size The width in pixels of the frame border.
Spacing The space in pixels, between the two frames.

File name When you create a page, Internet Creator gives it an 
automatic file name (p4.htm, etc.). If you would like to use a 
different, more meaningful, file name, type it into the Page File 
Name text box. Note: you should generally give the file an 
.HTM extension.

Setting Default Page Style Options
The default Page Style Options controls the setting for all new pages. To set the default, select "Default 
Page Style Options" from the Tools menu. Internet Creator will display the Default Page Style options 
dialog box. 
Make the changes you want, then click on the OK button.
To apply these changes to existing pages, click on the Apply Global button. (Be careful when using this 
option - it will change settings for every page in your site!)



The Freeze and Thaw Commands
The freeze command allows you to edit an Internet Creator page using a separate HTML editor. To freeze
a page:
1. Select the page you want to freeze.
2. Make a note of the file name, so you know which file to open in your HTML editor. (You can check the 

file name by selecting the page link in Internet Creator, and looking on the status bar for the file 
name.) The file is located in your project's "\html" directory.

3. Click on the Freeze button.
Remember, once you freeze a page, you will no longer be able to edit it using Internet Creator! 
Thawing a frozen page returns it to its original, pre-freeze state. To thaw a frozen page, select it, then 
click the Thaw button. 
When you thaw a page, you will lose any changes you have made since it was frozen. (You may want to 
make a backup copy before thawing.)



Horizontal Rule Setup
Internet Creator uses horizontal rules to separate elements of your page (including the navigation bar and
navigation links). To set up these rules, select "Horizontal rules" from the Setup menu.
These options are the same as the ones for the Horizontal Rule paragraph, except that when you close 
the dialog box, changes are made to all current horizontal rule paragraphs and/or all header and footer 
rules.



Paragraph Icon Setup
When you create a new paragraph, Internet Creator gives the paragraph a default icon based on the 
current theme. You can change the icon that Internet Creator uses for a particular paragraph by selecting 
"Edit Paragraph Icons" from the Setup menu.

Image To change the default image for a paragraph type, click on the 
paragraph name in the button list, then click the Image button. 
(For help selecting images, click here.)

Restore defaults Resets all the icons to the theme values.



Navigation Bar Setup
Internet Creator automatically creates a navigation bar at the top of each page. To change the images 
that are used for the buttons, select "Edit Navigation Bar" from the Setup menu.

Image To change the default image for a link, click on the link in the 
button list, then click the Image button. (For help selecting 
images, click here.)

Restore defaults Resets all the icons to the theme values.



The Auto Logo Creator
The Auto-Logo generator allows you to create a graphical logo for your site. Select    "Auto Logo Creator" 
from the Tools menu.

Logo Title and Subtitle You can arrange two pieces of text on your logo - the "Title" 
and the "Subtitle". (When you first open the Auto Logo creator, 
the Title is set to your site name.) You can change the font 
and colors of the text by clicking on the Fonts button and the 
Colors button. 

Text Layout The Text Layout controls the relative positioning of the Title 
and Subtitle. You can choose "Center Align Both", "Right Align 
Both", etc. You can also choose "Change Layout Yourself" - 
this allows you to manually drag the text in the picture.

Auto-size If Auto-Size is checked, Internet Creator will adjust the font 
size of the text as you type.

Shade If shade is checked, there will be a "shadow" underneath the 
text in the picture. Click on the Colors button to change the 
color.

Bkgrnd Fill the Bkgrnd check box to include a background image - 
click on the Browse button to select the image.

When you click the OK button, Internet Creator will prompt you to save the file in your project's HTML 
directory. The default filename is logo.gif; you can change it if you wish. You can now add the logo to your
site by creating an Image File paragraph, or by choosing a page logo in the Page Style Options.



The Auto Background Creator
The Auto Background Creator works the same way as the Auto Logo Creator does, but it is meant to 
create a "watermark" for your site's background image.
When you click the OK button, Internet Creator will prompt you to save the file in your project's HTML 
directory. The default filename is background.gif; you can change it if you wish. You can now use the 
background by selecting it in a page's style options. 



Creating and Using Templates
Internet Creator uses templates to let you create pages and paragraphs that you can use re-use in 
different projects. In addition, Internet Creator comes with a variety of useful templates for use in your 
web sites. This page gives directions for inserting templates and creating your own templates.

Inserting a template
1. Select "Template" from the Insert menu.
2. Select a template type. (Select "All" to see all available templates.)
3. Select the template you want. (As you click the templates, a description is displayed in the box 

below.)
4. Click "OK". Internet Creator will insert the template.
5. Edit the generated paragraphs (optional). For some of the templates (like the mail form and the Java 

applets) you will need to edit some of the parameters (email address, account name, etc.). 

Creating a template
1. Select the page or paragraph you would like to make into a template.
2. Select "Create Template" from the Edit menu.
3. Enter a "Type" (or category) for the template. Select one from the drop-down list, or type a new one.
4. Enter a name for the template.
5. Enter a description.
6. Click OK.
The template is now ready for use.



Optimizing the Database
If you have a large web site, periodically compressing your site database can lead to faster HTML 
generation times. To compress the database, select "Optimize Database" from the Tools menu.



Overview
Forms are one of the most powerful and popular features of the World Wide Web. They allow visitors to 
your site to enter information in a variety of formats. Forms can be as simple as a single "Yes or No" 
question, or as complicated as a detailed order form.
Every form you create on your site must be connected to a cgi-bin script. A script is a simply a computer 
program that can process the information from a form. There are scripts that simply e-mail the contents of
a form to the appropriate address, or scripts that perform more complicated actions. Scripts are generally 
located in a special directory on your hosting service's main server. (If you use Forman Interactive's 
Hosting Service, you will have free access to ICMail and Surveyor Script, powerful and flexible scripts 
specifically designed to collect information from visitors to your site.)
A very simple form

A more complicated form



Step 1: Start the Form Wizard

Internet Creator's Form Wizard makes it easy to add even complex forms to your site. To add a form to a 
page, select a location for the form, then click on the Form button on the Paragraph toolbar.
The Form Wizard displays the contents of your form in a web preview. As you make changes to the 
elements of your form, the web preview will reflect them. To get started with the Form Wizard, click the 
Next button.



Step 2: Enter a Form Caption
Enter a caption for the form.
Click on the Next button.



Step 3: Add Form Elements
The Form Wizard Toolbox Screen lets you add and remove the basic form elements: single line text 
control, multi-line text control, password text box, check boxes, radio buttons and list box.

Toolbox Screen
Toolbox These are the elements that are available for your form. To get 

a brief description of each element, hold the mouse cursor 
over the buttons.
To add an element to the form, click on the button, then enter 
the parameters for the element. The next few pages describe 
each element type in detail.

Form Elements This is the list of elements in your form.
Up and Down buttons Use these buttons to reorder the form elements.

Edit Modifies the parameters of the selected form element.
Delete Deletes the selected form element.

Single-Line Text Control

A single line text entry field. Use them to enable visitors to your site to enter a word or short phrase.
Description A label for the control - this is optional.

Form Element Name The name of the control. The name is used as an identifier for 
the field when the form is processed.

Default Value The text that is in the control when the user first sees it.
Width The width of the text box, in characters.

Maximum Input Length The maximum number of characters that the user can type 
into the field. Select "No" to allow unlimited input.

A single line text control

Multi-line text control

Creates a multiple line text entry field. Use them to let visitors enter a large piece of text.
Description A label for the field (optional).

Form Element Name The name of the control. The name is used as an identifier for 
the field when the form is processed.

Default Value The text that is in the control when the user first sees it.
Width The width of the text box, in characters.

Height The height of the text box, in characters.
Maximum Input Length The maximum number of characters that the user can type 

into the field. Select "No" to allow unlimited input.
Word Wrap Off: The text box will not attempt to wrap the text.

Virtual: The text will wrap as the user types, but no line 
breaks will be inserted in the returned text.

Physical: The text will wrap, and line breaks will be inserted 
where the wrapping occurs.



A multi-line text control

Password text box

The same as a single-line text box, except that the text is obscured as the user types it.
Text A label for the control - this is optional.

Form Element Name The name of the control. The name is used as an identifier for 
the field when the form is processed.

Default Value The text that is in the control when the user first sees it.
Width The width of the text box, in characters.

Maximum Input Length The maximum number of characters that the user can type 
into the field. Select "No" to allow unlimited input.

A password box

Check boxes

Lets a visitor choose one or more items from a list.
Description A label for the control - this is optional.

Form Element Name The name of the control. The name is used as an identifier for 
the field when the form is processed.

Options list The list of check boxes. To insert a check box, click the Insert 
button. To delete a check box, select it in the list, then click 
the Delete button. Use the arrow buttons to change the order 
of the check boxes.

Text The text of the selected check box.
Name The name (or identifier) of the control.
Value The value to return when the control is checked. ("Yes" is 

usually a good choice.)
Initially Checked The initial state of the control. Fill the check boxes.

A typical set of check boxes

Radio buttons



Creates a group of radio buttons. Similar to the check box control, except that only one "button" may be 
selected at a time.

Description A label for the control - this is optional.
Form Element Name The name of the control. The name is used as an identifier for 

the field when the form is processed.
Options list The list of option buttons. To insert an option button, click the 

Insert button. To delete an option button, select it in the list, 
then click the Delete button. Use the arrow buttons to change 
the order of the option buttons.

Option text The text of the selected option button.
Value The value of the control. The return value will consist of the 

"Form Element Name" and the value of the selected button. 
Initially Selected The initial state of the control. (Only one radio button can be 

selected.)

A typical set of radio buttons

List box

A list box in drop-down or regular format.
Description A label for the control - this is optional.

Form Element Name The name of the control. The name is used as an identifier for 
the field when the form is processed.

Visible rows The height of the control. A height of 1 creates a drop down 
list. 

Allow Multiple Selections If this option is set, more than one item can be selected. (Only 
works properly if height is greater than 1.) 

Options list The entries in the list. To insert a entry, click the Insert button. 
To delete an entry, select it in the list, then click the Delete 
button. Use the arrow buttons to change the list order.

Text The text of the selected list item.
Value The return value of the list item. 

Initially Selected The initial selection state of the item. 

Height = 3
Height = 1

Step 4: Submit and Reset Buttons
When the user click the Submit button, the browser collects all of the information in the form's fields and 
sends the values to the form's cgi-bin script. (For help setting up cgi options, click here.)

Submit button The form contains a button that sends the form contents. You 
can enter whatever text you like. 

Submit image Instead of a Submit button, you can have visitors send the 
form by clicking on an image.

Reset button Adds a button that returns all elements to their default values. 





Step 5: Setting up Form Processing
Every form you create needs to be connected to a cgi-bin script that handles the processing of the form 
fields. Check the documentation for the scripts (or ask the system administrator of your hosting service) 
you are using to determine how to fill in the Script Options. (If you are using Forman Interactive as your 
hosting service, you have automatic access to the Surveyor and ICMail scripts.) When you are done with 
the form options, click the Finish button.

Script Options
Post Method May be "Post" or "Get" 

Action/CGI-BIN The path (relative or absolute) to the script. 
MIMETYPE Most scripts require that you leave this blank. 

URL for script Most scripts require that you leave this blank.
Form parameters Any additional information that the script may require.

ICMail
ICMail emails the contents of a form to any email address you specify.

Post Method "Post" 
Action/CGI-BIN "/cgi-bin/icmail" 

MIMETYPE Empty 
URL for script Empty

Form parameters Name Return value
to The email address that you want the form contents 

sent to.
subject The subject for the email
nexthtm The page to be displayed after the visitor click on 

the Submit button. Enter "{nexthtm}" to have ICMail 
display a default thank-you screen.

Surveyor
Surveyor behaves much like ICMail, except that surveyor will add the form contents to a CSV file in your 
account's /admin directory.

Post Method "Post" 
Action/CGI-BIN "/cgi-bin/surveyor" 

MIMETYPE Empty 
URL for script Empty

Form parameters Name Return value
emailcopy The email address where you would like the form 

contents sent (optional).
subject The subject for the email (optional).
nexthtm The page to be displayed after the visitor clicks on 

the Submit button. 
file The name of the CSV file that you want to use. If 

it doesn't exist, Surveyor will create it for you. 
(You don't need to enter the .CSV file extension.)

acc_name Your Forman Interactive Hosting account name.
datetime Enter "Yes" to add a date/time field to the file.



The Commerce Wizard
The first step in setting up your site for commerce is to run Internet Creator's Commerce Wizard. Select 
"Commerce Wizard" from the Setup menu. 

Choosing an Ordering System
You can choose between two distinct ordering systems: "E-mail order forms" and "Interactive Shopping 
Basket". If you do not want to include an ordering system, select "Do not put an [Order] button…" (you will
still be able to use the item search features if you wish).



Setting up the Interactive Shopping Basket
The Commerce Wizard will help you set up Basic Options for the shopping basket. The wizard will also 
help you set up shipping options: Shipping Calculation Basis, Shipping Carriers and Shipping Calculation 
Method.

Basic Options
If you select the Interactive Shopping Basket System, the Commerce Wizard will ask you to enter a 
variety of information, including:
· Your FTP account information.
· The Currency and Weight symbols you would like to use for your transaction items.
· The path to the shopping basket program. (Usually "/cgi-bin/shop.cgi")
· A list of "Item Feature Search Fields". These will be used to provide a search facility for your site. For

Planet Books we entered "Title", "Author", "Publisher" and "Category". Visitors will be able to search 
for books based on these criteria.

· The Credit Cards and Payment Methods that your company accepts.
· A disclaimer that appears on all ordering screens. This allows you to add text like "All orders are 

shipped with 48 hours", "All our products have a 90-day money-back guarantee", etc.

Shipping Calculation Basis
The "basis" determines how your shipping charges will be calculated. Your shipping charges can increase
(or decrease) based on an order's total weight, total value or total number of units shipped. You can also 
set a shipping charge for each individual item, or you can have no shipping charges whatsoever.

Shipping Carriers
You can enter any number of carriers for your customers to choose from. 

Shipping Calculation Method
You can choose from four different calculation methods:



Enter data for each carrier (select a carrier from the drop-down list, then fill in the information for that 
carrier).

Flat Rate The shipping charges are a fixed rate based on specified weight, cost 
or quantity ranges.
For example, you can have orders under 10 lb. cost $15 to ship and 
orders 10 lb. and over cost $25 to ship.

Variable Rate The shipping charges are calculated on a per weight, per cost or per 
quantity rate. The rate varies based on weight, cost or quantity ranges.
You may also set minimum and maximum charges.
For example, you can have orders under 10 lb. Cost $2 per lb. To ship,
and orders 10 lb. And over cost $1.50 per lb.

Variable Rate Accrual The shipping charges are calculated on a per weight, per cost or per 
quantity rate. The rate is cumulative and varies based on weight, cost 
or quantity ranges. You may also set minimum and maximum charges.
For example, you can have the first 10 lb. of an order cost $2 per lb. to



ship, and the rest of the order cost $1.50 per lb.
This method most closely approximates most carriers' real shipping 
tables.

Simple Formula This is the simplest method. The shipping charges are calculated on a 
per weight, per cost or per quantity rate. You may specify a single per 
basis rate, and a minimum and maximum shipping charge.



Using the Shopping Basket
Visitors to your site order items through Transactional Item paragraphs:

The visitor enters the quantity of the item they would like, then clicks on the Add to Basket button. A new 
Shopping Basket is created for this customer.
The customer can press "Continue Shopping" to add more items to the basket. When they are done 
shopping and are ready to order, they click on Checkout Now. The Shopping Basket system presents the 
secure checkout form.
When the customer has filled in all of his or her information, they click on the Submit Form button. You will
receive a PGP encrypted copy of the order form.



Setting up the Email Order Form
If you select order processing by e-mail, your web site will have an Order button in the Navigation bar. 
When a visitor to your site clicks on the order button, an e-mail order form is displayed that allows them to
select the items they would like to order and to enter their shipping address, credit card information, etc. 
You can create an e-mail order form yourself, or Internet Creator can build one based on any 
transactional items you have on your site.

Basic Options
· Your FTP account information.
· The Currency and Weight symbols you would like to use for your transactional items.
· A list of "Item Feature Search Fields". These will be used to provide a search facility for your site. For

Planet Books we entered "Title", "Author", "Publisher" and "Category". Visitors will be able to search 
for books based on these criteria.

· The Credit Cards and Payment Methods that your company accepts.
· A disclaimer that appears on all ordering screens. This allows you to add text like "All orders are 

shipped with 48 hours", "All our products have a 90-day money-back guarantee", etc.
· An e-mail address for your order forms.

Secure Order Processing
In order to use secure order processing, your e-mail form must be located on a secure server. If you use 
Forman Interactive's hosting service, and use the Internet Creator-generated order form this will be set up
automatically.
Secure order processing allows "encrypted" transactions between your customers and your e-mail 
processing. This means that customers can feel safe about sending a credit number or personal 
information over the Internet.
To add secure order form processing to your site, select the "Allow secure order form processing option". 
Internet Creator will add a "Secure Order" button to your site's navigation bar: 

You may use an order form automatically generated by Internet Creator or one that you create yourself.
· If you use the Internet Creator order form, you will need to enter the path to your mail processing 

script and a secure location for the order form. These fields are already filled in for Forman 
Interactive's hosting service.

· You may also to choose to create your own order form:.

Unsecure Order Processing
With unsecure processing there is no attempt to encrypt or protect information on the form when it is sent.
In general, secure order processing is preferable to unsecure processing; however, you may still wish to 
offer unsecure processing as an option for your customers who are browsing the web using browsers that
do not support the secure transmission protocols.
To allow unsecure processing (and add an "Unsecure Order" button to your site's Navigation bar), select 
the "Allow unsecure orders" option. Internet Creator will add an "Unsecure Order " button to your site's 
navigation bar.

You may use an order form automatically generated by Internet Creator or one that you create yourself:
· If you use the Internet Creator order form, you will need to enter the path to your mail processing 

script. This field is already filled in for Forman Interactive's hosting service.
· You may also to choose to create your own order form.



Adding Transactional Items

The Transactional Item paragraph provides a structured format for products, prices and services. You 
must run the Commerce Wizard before adding any transactional items. To add a transactional item, click 
on the Transactional Item button.

Item name The name of your product. Click on the Select Icon button to choose an 
icon or image to represent the video file. You can position the icon to 
the left or right of the item name. (For help selecting images, click here.)

Item description Enter a description of your product. The description will appear just 
below the item name.

Quantity - Price breaks This is the pricing structure for your product. You may enter multiple 
prices to allow volume discounts. For example, if your pricing scheme is
$20 each for 1 - 4 units ordered, and $15 each for 5 or more, fill out the 
fields as shown:

Search Fields The Search Fields section lets you enter searchable information 
pertaining to your products. (Items that you leave blank will not appear 
on the generated page.) 

Unit weight The weight of a single unit. 
Item/Catalog number An item number for your product. If your organization has any internal 

stock numbers for products you can enter them here.
Shipping Charges This button is only available if you have selected "per item" as your 

shipping calculation method or are using the E-Mail ordering system. 
For each carrier, enter a shipping cost for this item.

Item Options The Item Options let you create options for your products. For example,
you could allow customers to order Tshirts by size and color. For help 
setting the Item Options, click here.



Item Options
For the Item Options to be available on your web site you must run the Commerce Wizard and select 
"Shopping Basket" as your ordering system. 
The item options allow you to set up user-selectable options for your transactional items. (For example, if 
you sell clothing, you can let users select sizes, styles and colors.) To set up advanced options for a 
transactional item:
1. Click on the Advanced Options button in the Transactional Item dialog box.

2. Select options for your product.

To select an option for your product, double-click on it in the Master List. If you don't see the option 
you want, click on the Add Option button to add a new one. Repeat this step until you have select all 
the options you want to offer.

3. Select and configure choices.

The choices are the selections available to the user for each option. (For example, "Large" and 
"Medium" are choices of "Size".) To set a choice, click on the option in the Selected Options list, then 
double-click on the choice in the Choice List. If you don't see the choice that you want, click on the 
Add button to create a new one. Selected choices appear in the grid.

For each choice you can enter a marginal price. If you are calculating shipping charges using weight 
as the basis, you may also enter a marginal shipping weight. This allows you to modify the price and 
shipping cost for products with particular attributes. For example, you could charge 50 cents more for 
T-shirts that are "XXL" - you can also increase the shipping weight of XXL T-shirts by .5 pounds.

Repeat this step for each choice that you want to offer your customers.

4. Click on the OK button.

This is how your options and sub-options appear to a customer.



Importing Transactional Items
If your organization or business stores its product information in a database, Internet Creator can import 
the database and create a transactional item for each product. (Internet Creator can read database file 
that are stored in Access, Paradox, FoxPro, Btrieve, Peachtree, Quickbooks or DBase format.) You can 
also use this feature to update the pricing information for items you have previously imported.
1. Select "Import Transactional Items" from the Tools menu.

2. Select your database type from the submenu. If your database is in Quickbooks or Peachtree format, 
select it from the submenu. For all other database types, select "Import Database Files". 

3. Select the type of your database, then locate and select it. If your database is in Quickbooks or 
Peachtree format, go on to Step 9. Otherwise, click the OK button to continue.

4. Select the database table that you wish to import from, then click OK.

5. In the Map Database Fields dialog box, map the fields in your database to Transcational Item    fields:

a. Click on a database field.

b. Click on an Internet Creator field.

c. Click the Map! button.

Do this for every field that you want to include. (Each Transactional Item must have an "item number" 
field. If you don't map one of the fields in your database to it, Internet Creator will generate item 
numbers automatically.)

6. If your database stores prices without decimal points, fill this check box. (Some databases store the 
value $4.95 as 495.)

7. Click the Continue button. Internet Creator will ask if you want to save your map settings.

If you will be using this database again you should click the "Yes" button. (If you do not want to save 
settings, go on to Step 9.)

8. Select a location and name for the settings file, then click the OK button.

9. In the Import Database File dialog box, the top list has a list of all the database records that are in 
your database but are not already in your site. The bottom list contains the information for all 
transactional items that are in your site. To add the new records to your site:

a. Select the database records you want, then

b. Click on the Import New Record button.

You can remove new records from the site by selecting them in the bottom list, then clicking the 
Remove New Record button. (Please note: you can not remove existing transactional items from this 
dialog box, you must delete them from the regular Internet Creator views.) 

10. Click the OK button.

11. Select a sort field. Internet Creator will insert the new Transactional Items sorted on the field you 
select.

12. Internet Creator will create new pages to hold your new Transactional Items. You must select the 
maximum number of items per page.

13. Click on Finish. Internet Creator will begin to create new Transactional items. This can take several 
minutes, depending on the size of the database.



Setting up Server Based Options
Internet Creator supports a variety of features that are server-based. To set up these options, select 
Server Wizard from the Setup Menu
Click on the Next and Back buttons to move through the wizard.



FTP Information
The FTP setup screen tells Internet Creator where to send your web site files.

You need to enter the ftp address of the host computer, your account name and password, and the target 
directory on the host. If you are unsure of what values to use, contact your hosting service administrator. 
(The target directory can be left blank on many hosting services.)



Email Setup
Internet Creator automatically sets up your site to have a navigation link to a standard mail submission 
form. You can modify the e-mail address this form points to, point the link to a form you create yourself, or
make the link access the mail program the users browser points to.



Newsgroup Setup
If your organization has a private newsgroup, you may wish to create a link to it on your site. To create the
link, fill the Display link to newsgroup radio button, and enter the path to your news server.



Search Form Setup
If you have a large site, it is a good idea to provide some searching functionality for people visiting your 
site. To add a Search button to your page, fill the Display link to search form radio button. Internet Creator
will add a Search button to the Navigation bar, and a search link at the bottom of every page:

You can use the standard Internet Creator generated search form or you can create your own.
The basic Internet Creator search form allows your visitors to search your site based on keywords that 
they enter. The search will return all pages that contain the keywords.
If you have included Transactional Items and Item Feature Search Fields in your web site, Internet 
Creator will generate a search page that allows users to select search criteria based on keywords or on 
the search fields.



Search Engine Information
The Search Engine Information you enter here makes it easier for search sites such as AltaVista and 
Lycos to find your site.



Using the FTP Wizard
Publishing your site is the process of putting all of your files onto a Web Server that makes the files visible
to the rest of the world.
1. Generate your site. Even if you are using the Auto-Generate option, it is a good idea to generate your 

site before you upload it.

2. Connect to your Internet Service Provider.

3. Click on the Auto Upload Site button. Internet Creator will start the FTP Wizard.

4. Enter your Hosts FTP server, account name, password and host directory. (On many servers, the host
directory is optional.) If you are unsure of any of this information, contact your hosting service 
administrator.

5. Select files to upload. You may upload all the files on your site, the files that have changed since the 
last time you uploaded, or you may select the individual files you want to upload.

6. If your host supports automatic unzipping of files, you may wish to use the compression feature. 
Using compression usually makes the upload process much faster. (Forman Interactive does provide 
automatic unzipping. If you use a different host, contact your administrator to see if they support this 
feature.)

7. Select the individual files you wish to upload. (If you are uploading All Files or Changed Files Only, 
you will see a list of the files that are to be uploaded.)

8. Click the Upload button. Internet Creator will open an FTP connection and begin to upload your site:

When the upload is complete, Internet Creator will give you a Congratulations screen:



Import Database File Dialog Box
The Import Database File dialog box lets you choose which records from your database are made into 
Transactional Items.

Record Lists The top list contains all of the records in your database that 
have not been copied into Transactional Items.
The bottom list contains all records that have been copied into 
Transactional Items. Existing Transactional Items are marked 
with an O, items that have been selected for conversion are 
marked with an N. 

Import New Records In the top list, select the records that you want to add to your 
site, then click on the Import New Records button.

Remove New Records You may remove new records from the bottom list by clicking 
on the Remove New Records button. (You cannot remove 
records that have been imported in the past - the ones marked 
with an O.)

L / R View
T / B View

You may view this dialog box with the Record Lists arranged 
Left/Right or Top/Bottom. Click on this button to switch views.

Inventory Item
Service Item

(QuickBooks databases only.) You can display Inventory items,
Service items, or both.

See Also:
Importing Transactional Items



Internal Link Dialog Box
An internal link creates clickable text that leads to another paragraph in your site. Select the target 
paragraph from the list.



Special Characters Keyboard
To make the process of inserting special characters a little easier, Internet Creator includes a built-in 
Special Characters Keyboard.
Click on the buttons representing the characters you wish to use - their HTML codes will appear in the 
text box at the top of the window. When you are done selecting characters, click the OK button and 
Internet Creator will insert the special text into your paragraph.



Map Database Fields Dialog Box
The Map Database Fields dialog box maps the fields in your database to Transactional Item    fields.

Database Fields The list of fields in your database.
Transactional Item Fields The fields that Internet Creator uses to create Transactional 

Items.
Mapping Summary The currently mapped fields

Map button Creates a mapping between a Database Field and a 
Transactional Item Field.

Unmap button Removes an existing mapping.

See Also:
Importing Transactional Items



Image Viewing and Scaling dialog box
Use the Image Viewing and Scaling dialog box to select and resize images and icons.

Select Image Selects an image file.
Remove Image Removes the image from the current paragraph.

Standard Icon Size Resizes the image to a typical icon size
Height and Width You can enter a new height and width (in pixels) for the image. 

Click on Resize to make the change. Fill the Keep Proportions 
check box to keep the ratio of height to width constant.

See Also:
Using Images and Icons 



Transactional Item Sorting
The final stage of importing a database is creating Transactional Items.

Sorting Field The fields that Internet Creator will use to order the new items.
Maximum Items per Page The number of items on each new page.

See Also:
Importing Transactional Items




